Answer Key PN

Trackpad iPRO (Ver. 4.1)

Categories of Computers and Computer
Languages

One  Touch Learn )

A. 1 a 2. b. 3. d 4. c 5. b.

B. 1 F 2. F 3. F 4. F 5T

C. 1. Microcomputer 2. laptop 3. instructions

4. programming 5. assembler
lets Do It

A. 1. A minicomputer is bigger, more expensive, and more powerful than a microcomputer. It
is mainly used for scientific and engineering computations and can serve multiple users at
once.

2. Anembedded computer is a special type of microprocessor based system that is developed
for performing a specific task, such as those used in digital cameras, ATMs, and microwaves.

3. Cand BASIC are the types of 3GL.

4. An assembler is a program used to translate assembly language into machine language
so that the computer can understand and execute the program.

5. A computer language is the means by which instructions and data are transmitted to the
computer to perform specific tasks. It includes a set of words, symbols, and codes that the
computer can understand.

B. 1. Ahandheld computer is a small computing device that can be held in the hand or kept in
the pocket. It typically has a touchscreen for input.
Examples: Smartphone and Smartwatch
2. Adigital computer is a type of computer that uses digits (Os and 1s) to generate, process,
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and display data.
Examples: Laptop and Smartphone
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3. The differences between HLL and LLL are:

HLL LLL
a. Machine independent a. Machine dependent
Easy to understand b. Difficult to understand
Coding contains English words ¢. Coding isin the form of 0 and 1

or ‘'Mnemonics’

d. Example: C, C++ d. Example: Machine language,
Assembly language

4. The advantages of High-level languages are:
(i) High-level language is user friendly.
(i) In High-level language it requires less time to write a program.
(iii) High-level language is easier to maintain.
(iv) High-level language is problem oriented rather than ‘Machine Based'".

5. A Compiler translates the entire source code into machine language at once and shows all
errors together.

An Interpreter translates and executes the source code line-by-line, showing errors one at
a time.

1. Yes, Mini is correct. A washing machine with features like water heating and level sensing
contains a microprocessor and is designed to perform specific tasks, which makes it an
embedded computer.

2. 1st Generation — Machine Language (0s and 1s)
2nd Generation — Assembly Language (uses mnemonics)
3rd Generation — High-Level Languages like C, BASIC
4th Generation — Very easy-to-use languages like SQL, Python

5th Generation — Natural Languages used in Al and expert systems
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Do it yourself.

m File Management—Organisation of Data

One  Touch Learn )
A. 1. b 2. C 3. C 4. a. 5. a.
B. 1. F 2. T 3. F 4. F 5. T
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C. 1. Fileformat 2. sorting 3. .pptx 4. Partitions 5. asterisk
D. 1 d 2. c 3. e 4. a. 5. b.

Lets Do It

A. 1. Data is arranged in a computer by type, by size, by name and by date of creation and
modification.

Sorting is used to arrange the files in a computer.
Examples of file extensions are .docx and .pptx.
Show windows side by side

[

The Asterisk (*) is used to replace a string of characters, while the Question mark (?) is used
to replace only a single character.

2. File Explorer is a tool in Windows that helps us to organise and manage files and folders.
It allows us to copy, move, rename, sort, and search files and folders.

3. The two wildcards used are Asterisk (*) and Question mark (?).
Asterisk is used to replace a string of characters in the search term. This implies that if we

place an asterisk in our search term, then Windows will search for a file name or folder
name with the given characters and any other text string.

Question mark replaces a single character or symbol. It represents only one character, so
it searches for only one character. For example, when we type “C?M" in the search box of
the File Explorer, it will display only files or folders with names that have three characters,
where the first and third characters are C and M.

4. When we work on a computer, we might need to work on more than one file at a time or
open more than one application at a time. For example, while working on a Word file, we
would be using Google for searching notes and PowerPoint for making the presentation.
If we need some images for the presentation, we would have the image folder open in File
Explorer as well windows allows us to work with multiple applications .

C. 1. Shecanidentify them by their file extensions. The text file will have .docx and the presentation
file will have .pptx extension.

2. Yes, he should use the Sort by Name option to organise his files alphabetically and quickly
locate the ones starting with "HW.”

Higher Order Thinking Skills (HOTS)
1. I will type k*d in the search box. The asterisk (*) will replace any number of characters
between 'k’ and ‘d".
2. File formats are important because:
(i) They help the operating system to identify the type of file.

(i) They decide which application can open the file correctly.
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Do it yourself.

m Word Processor—Tabular Representation

One Touch Learn )

A. 1. b 2. b. 3. C 4. a.

B. 1 F 2. T 3. T 4. F 5. F

C. 1. Resizing 2. Merging 3. Layout 4. Design 5. Delete Rows
&

Lets Do It

A. . The intersection of a row and a column in a table is called a cell.

1
2. Table Styles is a feature with which a user can format the entire table quickly.
3. Shading is an option to apply colors to cell or group of cells in a table.

1

B. . To add a row in a table, follow these steps:

Step 1 Select the row where you want to add an additional row.

>>>>>>>>>>>>>>>> Trackpad iPRO (Ver. 4.1)-VI (Answer Key)



Step 2 Click on the Layout tab.
Step 3 Click on the desired option.
2. Toinsert a table, follow these steps:
Step 1 Click on the Insert tab.
Step 2 Click on the Table drop-down arrow.

Step 3 Click on the top left corner of the grid and drag the mouse to highlight the number
of columns and rows you want in the table.

The table will be inserted into the document.
3. To merge two cells, follow these steps:

Step 1 Select the cells to be merged.

Step 2 Click on the Layout tab.

Step 3 Click on the Merge Cells command.

The selected cells are merged as one cell.

4. Splitting cells in a table is dividing one cell into two or more cells whereas Merging
cells in a table is combining two or more cells in the same row or same column into a
single cell.

C. 1. Aman should use Tables to organise the data in easy to read method.
Ms Shalini should use Merge Cells option.
Higher Order Thinking Skills (HOTS)
1. To apply Border and Shading styles, follow the given steps:
Step 1 Select the table.
Step 2 Click on the Design tab.
Step 3 Click on down-arrow in Borders.
Step 4 Select Borders and Shading.
Step 5 Modify the Style, Color and Width options from the Borders tab.
Step 6 Click the down arrow button of the Fill option under the Shading tab.
Step 7 Choose the colour of your choice.
Step 8 Click on the OK button.

2. AutoFit Contents options is in Cell Size group under Layout tab. AutoFit is used to make
the column in a table automatically fit the contents.

crock [ihe, code 1

1. Delete 2. Insert above 3. Insert below
4. Insert Left
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Do it yourself.

mWLdProcessor—Mail Merge

One  Touch  Learn )

w »

1
1
C. L
3.

%
(™4
Lets Do It )

A. 1
2.
3.

w
l_l

a. 3. ¢ 4. a. 5. a.
T 3.7 4. T

Mail merge 2. Main document

Mailings 4. Write and insert fields

@

Data source is a separate file that contains all information about recipients of the letter.
The name of the command used to add addresses list is Type New List.

Two uses of Mail Merge are: (any two)

(a) It saves time and effort.

(b) It allows to make changes in several letters very quickly.

. Three advantages of Mail Merge are:

(i) It saves time and efforts.

(i) It allows to make changes in several letters very quickly.

(iii) It allows to produce thousands of letters quickly.

There are three main components of Mail Merge in MS Word which are as follows:

(i) Main Document: It is a document that contains the text of the letter which we want
to send to our friends.

(i) Data Source: It is a separate file that contains all information about recipients of the letter

(iii) Merged Document: It is the final document created by merging the Main Document
and Data Source. It contains a list of letters with text and detail of a person.

Merged Document is the final document created by merging the Main Document and Data
Source. It contains a list of letters with text and detail of a person.

Rita should use Mail Merge feature to accomplish this efficiently.
Gunjan can use the Edit Individual Documents option after completing the Mail Merge.

Y
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Higher Order Thinking Skills (HOTS)

1. The third component of Mail Merge is the Merged Document. It contains a list of letters
with the text from the first component, the Main Document, and the recipient details from
the Data Source.

2. The three ways of selecting recipients for Mail Merge are:
(i) Type a New List
(i) Use an Existing List

(iii) Choose from Outlook Contacts.

Crack The Code %
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Do it yourself.

n Presentation—Visual Effects

One Touch Learn )

A. 1. b 2. d. 3. b 4. c 5. a. 6. b.
B. 1 F 2. F 3. F 4. T 5T

C. 1. Insertvideo 2. slide 3. Action settings 4. object 5. create
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Lets Do It
A. 1. Slide Show view allows to view the presentation in full screen mode.
2. Slide Sorter View shows all the slides of a presentation in a miniature version.

Slide transition determines how presentation moves from one slide to next whereas
Animation is the addition of special visual/sound effects to the text and graphics in a
slide.

B. 1. Toinsert sound to a presentation, follow these steps:
Step 1 Click on the Insert tab.
Step 2 Click on the Audio command.
Step 3 Choose the desired option.
Step 4 Select the file.
Step 5 Click on the Insert button.
Step 6  Click on Play/Pause button to play or pause the audio.

2. Action button is used to move from one slide to another and play media files. There are
12 different types of action buttons available in PowerPoint.

3. Four views in PowerPoint are:
a. Slide Sorter View
b. Notes Page View
c. Reading View
d. Slide Show View

C. 1. Rohan can use the Action button to move to the next slide of the presentation.
2. Pooja can use the Animation feature to different objects on her slide that must appear in
a different way in the slide show.
Higher Order Thinking Skills (HOTS)
1. Notes Page View to see the slide with your speaker notes.

The Notes Page view shows you what your notes pages look like in printed form. In this
view, the slide of your presentation and the speaker notes that you have added within the
Notes pane for each individual slide appear together

2. To import data, follow the given steps:
Step1 Click on the Insert tab.
Step 2 Click on the Object command.
Step 3 Select the Create from file option, if you want to import an existing file.
Step4  Click on the Browse button. The Browse dialog box appears.
Step 5 Navigate the location where you have saved the file.
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Step 6  Select the desired file.
Step 7  Click on the OK button.
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Worksheet-1
(Based on chapters 1 to 5)
A. Desktop Laptop
PDP-11 PDP-8
ATM Microwave

Smartphone Smart watch

The process of writing a program is called programming.

Wildcard is a special character which is used to represent one or more characters.

A file extension is a group of two or more characters used to identify the type of a file.
Splitting refers to dividing one cell into two or more cells.

The Mail Merge feature in MS Word is used to create personalised letters to be sent to
many people.
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Notes pane is the area where a speaker can write notes for himself.

Tables Insert
Cell size Layout
Cell size Layout
Merge Layout
Table styles Design
Hybrid

Natural Languages
Assembler

Right-click

Table Resize Handle
Data Source
Animation

Slide Sorter View

Test Sheet-1

(Based on chapters 1 to 5)

Section A
b. 2. d. 3. ¢ 4. c
d. 6. c 7. b. 8. d
Minicomputer 2. Microcomputer 3. fifth
MP4 5. Borders and shading 6. Mailings
T 2.7 3.7 4. T 5T
Section B

A smart watch is a computing device which you can wear on your wrist. It provides the
features of an older watch and some advanced features of smartphone like connecting to
the internet, using mobile apps, and making phone calls, etc.

PACE, Titan, Sunway Taihulight and Pratyush are the examples of Supercomputer.

Table is very useful in enhancing and analyzing the data.

Merged Document is the final document created by merging the Main Document and Data
Source.

The Notes Page view shows user how notes pages look like in printed form. In this view,
slide of our presentation and the speaker notes that we have added within the Notes pane
for each individual slide appear together.

A low-level language is a programming languages that is machine dependent. A program
written in machine dependent language runs only on one particular type of computer.
Two low-level languages are: Machine Language and Assembly Language.

=
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A file extension is a group of two or more characters used to identify the type of a file. Two
examples are: JPEG and MP4.

A table is an arrangement of text in form of columns and rows.
Steps to apply a table style:

Step 1 Select the table.

Step 2 Click and select the design of your choice.

The selected style will be applied to the table.

Three advantages of Mail Merge are:

(i) It saves time and efforts.

(i) It allows to make changes in several letters very quickly.

(iii) It allows to produce thousands of letters quickly.
Reading View is used when you want to view a presentation not in fullscreen but in a
window with simple controls that make the presentation easy to review.

Slide Sorter View shows all the slides of a presentation in a miniature version and allows
to change their order.

m Scratch Programming—Game Creation

One  Touch  Learn )

A. 1 c 2. a 3. c 4. a. 5. b.

B. 1 F 2. F 3. F 4. T 5T

C. 1. Pen 2. regular 3. stamp 4. sound 5. operators

D. 1. control block 2. looks block
3. motion block 4. events block

(r:/‘/‘
Let's Do It

A. 1. Penblocksin Scratch allow a Sprite to draw shapes and plot coloured pixels on the screen.
2. The components of Scratch window are Sprite, Stage, Blocks palette and Scripts area.
3. Repeat block is used to draw a pentagon.
4. Two conditional control blocks are: Forever and Forever-if.

B. 1. The four methods to choose a sprite are:

N
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(i) Paint a new sprite
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(i) Choose a sprite from the library
(iii) Upload a sprite from file
(iv) A new sprite from the camera.
2. Blocks are puzzle piece shapes that are used to give instructions to the computer.
Two conditional blocks are: Control and Events.
3. The repeat block is used to run a set of instructions for a specified number of times.

The forever block is used to run a set of instructions continuously until stopped. The
instructions inside this block will be executed in a loop until the Stop button is clicked by
the user.

P

/7 erase all

7 pen down

goto mouse pointer «

5|

2. Sam'’s Scratch Game — Picking Up Garbage
To create a game where a sprite picks up garbage items from the stage.

Block Usage in Game
when green flag clicked Starts the game
forever Keeps checking for collisions or movement.
if <touching [garbage sprite v]> then Detects when the player touches garbage.
hide Hides the garbage sprite when it's picked.
change score by 1 Increases score each time garbage is picked.
go to [random position] Makes garbage appear in random places.
say [Good Job!] for 2 seconds Gives feedback when garbage is picked.
Show To make garbage appear again (if reused).
set score to 0 Resets the score when the game starts.
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Higher Order Thinking Skills (HOTS)
1. Sounds tab

2. You can change the turn to 120 degrees to correctly draw a triangle.

Crack The Code
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Do it yourself

HTML—AnN Introduction

F

One Touch Learn )

A. 1 a 2. ¢ 3. c 4. d. 5. b.

B. 1 F 2. F 3.7 4. F 5T

C. 1. Markup 2. <Head> 3. <B»> 4., <P> 5. <Sub>
Lets Do It

A. 1. HTML s a markup language that describes the structure of the web page.
2. The tags that have both opening and closing tags are called Container Tags.

3. A web page is a document that contains text, graphics, videos, audios and links to other
pages.
B. 1. The <HTML> tag tells the web browser that the text contained between <HTML> and
</HTML> is a web page and can be viewed using a web browser. Every web page coding
must starts with the <HTML> tag and ends with the </HTML> tag.

The <body> tag specifies the main content of the web page. The text and other elements
contained between <body> and </body> tags are displayed on the web page. It is a
container tag.

2. Rules for writing HTML codes are:
(i) Values given to the attributes should be enclosed within the double quotes.

£5)
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(i) Tag name should not contain spaces.
(iii) There should be no spaces between < and > in a tag.
(iv) Tags must be nested correctly using the LIFO principle.
3. a. The <BR> Tag: The <BR> tag is used when you want to start a new line but do not
want to start a new paragraph.

b. The <HR> Tag: The <HR> tag is used when you want to divide your web page
into different sections. It is also used when you want to draw a line between two
paragraphs.

C. 1. (i) ALIGN Attribute: Used with tags like <P>, <H1>, etc, to align content (left, right,
center, justify).

(i) <CENTER> Tag: Centers content on the page. It's deprecated in HTML5, and CSS
should be used instead.

(iii) Similarities: Both are used to align content.

(iv) Differences: ALIGN works with various tags, while <CENTER> is specific to centering
content. The <CENTER> tag is now deprecated in HTML5.

2. Right-click the HTML file, select "Open with” and choose a text editor (e.g., Notepad). Edit
the code, save it, and refresh the browser to view the changes.

Higher Order Thinking Skills (HOTS)
1. Block Level:

(i) <P>:Represents a paragraph. It takes up the full width of its container and starts on
a new line.

(i) <H2>: Represents a second-level heading. It starts on a new line and takes up full width.

(iii) <HR>: Creates a horizontal rule (line) and occupies the full width of its container.

Text Level:

(i) <SUB>: Represents subscripted text. It does not start on a new line and is used within
other content.

(i) <B>: Makes text bold. It is a text-level element that applies a style to the text without
affecting layout or flow.

2. (i) Text Editor: Used for writing and editing the HTML code. It allows the user to create
or modify the structure of the webpage using HTML tags.

(i) Microsoft Edge: A web browser used to display the webpage as rendered by the
HTML code. It executes the HTML code and shows the visual output of the webpage
but cannot edit the code.

8.0
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m Online Surfing and Cyber Security

One Touch Learn )

A. 1. d 2. a 3. c 4. d. 5. a.
B. 1T 2. F 3. F 4. T

C. 1. Carding 2. E-greeting 3. Chat 4. cyber security
Let's Do It

A. 1. Phreaking crime is committed against telephone companies by using computers with the
goal of making free distance calls, impersonating directory assistance or other operator
services, diverting calls to numbers of the perpetrator’s choice, or tapping phone lines.

2. Anewsgroup is an online discussion group where people talk about a specific topic. Everyone
in the group is interested in the same topic and shares their thoughts and ideas.

3. Cloud storage is a service where the users are able to store and manage data on remote
server in place of their local computer.

w
'_l

. Three Safety measure while using Internet are:

(i) Never provide personal information, such as address, phone number, or school name
or location.

@’3
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(i) Keep our browser’s privacy settings ON.
(iii) Use the Internet only in the presence of our elders.
2. Different ways of communication through Internet are:
(i) E-mail: E-mail stands for electronic mail. We can send messages and files from our

computer to your friend’s computer and vice-versa using e-mail service. It is fast and
generally delivered within few seconds (depending on the network speed) after sending.

(i) Video Conferencing: We use telephones and mobiles to talk to your friends and
relatives. With the advancement in technology, we can now see the person with whom
we are talking. The technique of watching the person while talking to him is called video
conferencing. In video conferencing, there can be two or more persons at different
locations simultaneously talking to each other by both audio as well as video.

(iii) Voice-over-Internet Protocol (VoIP): Voice-over-Internet Protocol (VoIP) is a
technology which gives calling facility over the Internet.

3. The differences between hacking and cracking are:

Hacking Cracking

a. Practice of modifying computer a. Process of stealing personal information.
hardware and software.

b. People engaged are called as hackers.  b. People engaged are called as crackers.

4. There are various types of cyber threats. Some of them are as follows:

(i) Data Diddling: Refers to the process of changing the data going into or out of a
computer.

(i) Phreaking: This crime is committed against telephone companies by using
computers with the goal of making free distance calls or tapping phone lines.

(iii) Cloning: This refers to a fraud in which scanners are used to steal the electronic serial
numbers of cellular phones, which may used for billing purposes and making broadcast
calls.

(iv) Carding: This refers to the process of stealing credit card numbers online, to be resold
or used to charge merchandise against victim's account.

(v) Hacking: Computer hacking is the practice of modifying computer hardware and
software to accomplish a goal outside of the creator’s original purpose.

(vi) Cracking: The process or stealing personal information, changing financial data, breaking
security systems to gain unauthorized access of computer systems is called cracking.

C. 1. (i) E-banking via bank apps or websites: Fast and secure, funds can be transferred
instantly.

(i) PayPal or Google Pay: Instant money transfers with minimal fees, easy to use.

2. This was not the right action, as it is important to respect privacy and use your own accounts.
The alternative is to ask for an extension from the teacher or submit the project as soon
as possible using his own email account.
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Higher Order Thinking Skills (HOTS)
1. Risks include:
(i) Identity Misrepresentation: People may not be who they claim to be online.
(ii) Physical harm: Meeting an unknown person could lead to danger or harm.
(iii) Exploitation: Risks of being exploited or manipulated.
Always ensure that meetings are supervised to protect personal safety.

2. Not advisable: Social networking services can be distracting, may expose students to
inappropriate content, or lead to cyberbullying. However, they can also offer educational
opportunities if used responsibly.
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mE-Lail—An Introduction
One _ Touch . Learn k%
A. 1 c 2. a 3. d. 4. b. 5 c 6. C
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B. 1
C. L

F 2.7 3. F 4. F 5T 6. F
Bcc 2. To 3. Cc 4. Subject 5. Sent

@

Lets Do It )

A. 1.

The Internet is a global computer network that connects hosts and end systems around
the world.

2. We use emoticons to represent facial expressions.

3. Yes, we can send a video file as attachment in an e-mail.

4. An electronic mail or e-mail cab be defined as the process of exchanging messages

electronically through a communication network by using the computer.

Signing in means accessing your e-mail account by providing your username and password,
enabling you to send, receive, and manage e-mails.

E-mail has various advantages, some of them are:

a. An e-mail can be sent anytime and from anywhere in the world.

b. An e-mail can be sent to many people at a time.

¢.  Ane-mail can be easily forwarded to anyone without typing it again.
d. Sending an e-mail is fast in comparison to traditional mails.

Trash is the folder where all deleted e-mails are usually stored for a defined time period.
The e-mail will only be permanently deleted if you delete it from the Trash folder.

Sumit can attach the music file to the e-mail using the “Attach files” option. If the file is
too large (over 25MB), Sumit can upload it to a cloud storage service (e.g., Google Drive)
and share the link in the e-mail.

Sushant can use the Bcc (Blind Carbon Copy) field to send the e-mail to multiple recipients
without them seeing each other’s email addresses.

Higher Order Thinking Skills (HOTS)

1
2.

>>>>>>>>>>>>>> Trackpad iPRO (Ver. 4.1)-VI (Answer Key) 19

Bold text in the Inbox indicates unread e-mails.

(i) Ensure to sign out or log out after checking e-mails.
(ii) Use strong, unique passwords for the e-mail account.
(iii) Enable two-factor authentication for added security.
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Do it yourself

One  Touch  Learn )

A. 1 a 2. a 3. b 4. d. 5. a.
B. 1 F 2.7 3.7 4 F 5T
C. 1. blog 2. blogger 3. online 4. cash on delivery 5. Drive

Lets Do It

A. 1. Google Docs option is used to create a document similar to a Word document on Google
Drive.

2. Two modes of payment are Net Banking and E-Wallet.

3. OTP stands for One-Time Password

£5)
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4. Two e-commerce websites are www.amazon.com and www.flipkart.com.

B. 1. Ablogorweblogisaninformational website that often contains information on a particular
subject. Podcasts and Photologs are types of blogs.

2. The process of making digital recordings (audio or video) that are available for downloading
is called podcasting.

Two examples of websites that provide podcasting services are https://itsamonkey.com/
and http://revisionisthistory.com.
3. Three advantages of e-commerce are:
(i) It allows us to choose a product from a broad range of products.
(i) It saves our money and time.
(iii) It allows us to sell or buy products and services at any time.

C. 1. Ritucan use platforms like Blogger or WordPress to create and publish her blog about her
travel experience.

2. Alia can use cloud storage services like Google Drive, Dropbox, or OneDrive to store her
files and access them from any device with an Internet connection.

Higher Order Thinking Skills (HOTS)

1. Google Drive allows you to share a presentation with team members. You can click the Share
button, enter their email addresses, and assign them editing or commenting rights. Multiple
team members can work on the presentation in real time, and changes are automatically saved.

2. (i) Similarities: Both methods involve buying products, provide options to choose, and
have payment methods.

(i) Differences: Shopping in a physical store allows you to touch and try products, while
e-commerce offers convenience and the ability to shop anytime. Physical stores provide
immediate purchase, whereas e-commerce might have delivery delays.

(iii) Preference: E-commerce is preferred due to the convenience of shopping anytime
and comparing multiple products in one place.
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Do it yourself
Worksheet-2

(Based on chapters 6 to 10)

A. 1. Backdrop is a background of the stage.
2. Sprite is the actor which acts on the stage. The default sprite in Scratch is an orange cat.

3. Stage is the main working area to draw or perform action. It shows the output of the
program.
4. Scripts area is the area where we pick and drop the blocks from the Blocks Palette to create
a script/program.
foal
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5. Green Flag is used to run a scratch program.
B. 1. Adobe Dreamweaver Amaya
2. <BR> <HR>
3. E-mail E-Banking
4. Net Banking E-Wallet
C. 1. Setpen colorto
2. Stamp
3. Web browser
4. Element
5. Attribute
6. Social Networking
7. Cloud Computing
8. Spam
D. 1. Hypertext Markup Language
2. Standard Generalized Markup Language
3. Card Verification Value
4. One-Time Password
5. Common Business Oriented Language
Test Sheet-2
(Based on chapters 6 to 10)
Section A
A. 1 a 2. c 3. a 4. d.
5. d 6. d. 7. a. 8. b.
B 1. F 2. T 3. F 4. T 5 F
C. 1. Sound 2. Head 3. e-greeting 4. Outbox 5. Gmail
Section B
A. 1. Repeat Block is used to draw a Pentagon.
2. Empty tags contain only opening tag. They do not have closing tag.
3. In place of </h4>, </h1> should be used.
4. Hacking is when someone accesses someone else’s computer or account without permission.
5. The Compose button on Gmail is used to create a new email.
6. The meaning of F9 acronym in an e-mail is Fine.
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7. E-commerce: The process of buying and selling goods or services online is called
e-commerce. E-commerce is also known as electronic commerce.

Online Shopping: The process of purchasing products online is called online shopping.
You can purchase almost everything online. We must have registered with the e-commerce
website from which we want to buy products.

1. Blocks are puzzle piece shapes that are used to give instructions to the computer.
Four pen blocks are:

(i) Penup (i) Pen down
(iii) Stamp (iv) Set pen color to

2. The <body> tag specifies the main content of the web page. The text and other elements
contained between <body> and </body> tags are displayed on the web page. It is a
container tag.

(i) class
(i) style
3. <html>
<head> </head>
<body>
Chemical formula for Sulphuric acid is H<sub>2</sub>SO<sub>4</sub>.

<BR> Maths formula for (A + B) <sup>2</sup> is A<sup>2</sup> + B<sup>2</sup>
+ 2AB.

</body>
</html>
4. Four Safety Measures while using Internet are:

(i) Never provide personal information, such as address, phone number, or school name
or location.

(i) Keep the browser’s privacy settings ON.

(iii) Use the Internet only in the presence of the elders.
(iv) Do not share passwords (other than the parents or teachers).

5. orangeeducation123 is the username and gmail.com is domain name.

6. The process of buying and selling goods or services online is called e-commerce.
The e-commerce is also known as electronic commerce.

The three Payment modes are:
1. Debit or Credit Card
2. Net Banking

3. E-Wallet
&
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